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Computer	 :	 Computers is a comprehensive series of eight books designed specifically 
for the needs and requirements of the students studying in classes 1-8.  This 
series perfectly complies with the NCERT syllabus criteria and the National 
Curriculum Framework's vision. In keeping with NEP 2020’s guidelines, the 
series adopts an interactive approach to make it possible for the learners to 
enjoy computers.  This book includes enough questions in accordance with 
the NEP criteria. The fundamental principles of NEP which are recognizing, 
identifying and fostering the unique capabilities of each student, respect 
for diversity, and consideration for the local context in all topics, are always 
kept in mind while framing the book.

		  The topics are introduced in a way that children experience and learn 
through exploration.

		  Child-friendly language and contextual images have been incorporated 
throughout the series to make the material more understandable for young 
readers. This allows them to connect what they read and relate it  to the 
views, ideas, and experiences they encounter every day. 

Salient Features of the series:

Learning Outcomes	 :	 It guides both the teacher and the students towards the correct direction 
of efficient learning. It establishes the path of learning for efficient and 
superior learning results.

Warm Up	 :	 Children can connect their prior knowledge to the chapter's topic through 
simple yet engaging activities.

Teacher’s note 	 :	 An outline of guidelines for teachers to follow in the classroom in order to 
make lessons interactive and discussion-based.

Let me answer	 :	 Questions related to the topic which are  essential for checking pupil 
understanding and keeping them engaged with the task at hand.

Do You know	 :	 An interesting piece of information related to the topic.

Remember It 	 :	 Additional information about the topic to encourage children to wonder 
about various surroundings.

Kids’ IQ 	 :	 These questions have been included to reinforce learners to think,analyse 
and apply.

Up skill your 

Intelligence	 : 	 Ample exercises with a range of questions to support learning.

Critical Thinking	 :	 Questions which allow the learners to think clearly and rationally. 

Team Work 	 :	 It enables the students to collaborate with others.

		  The content is structured and well graded. Sincere efforts have been made 
to prevent any inconsistencies and make this series a perfect complement 
to the students' education. Any worthwhile recommendations for the 
improvement of the series are always welcome and greatly appreciated.

								          	   Author
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It shows the right path of learning 
to the teacher as well as students. It 
establishes the direction of learning 
for efficient and superior learning 
results.

Children can connect their prior 
knowledge to the chapter's topic 
through simple yet engaging 
activities.

An outline of guidelines 
for teachers to follow in 
the classroom in order to 
make lessons interactive 
and discussion-based.

Additional information about the 
topic to encourage children to wonder 
about various surroundings.
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Remember It

It aids in providing a brief summary 
of the entire chapter.

Let's Recall

These questions have been included 
to reinforce learners to think,analyse 
and apply.
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Computer Language

At the end of this lesson, the students will be able to:
)) Comprehend Programming language.
)) Learn about types of programming languages.
)) Know the history and development of Programming Languages.

Learning Outcomes

Warm-up
We use different modes to communicate. Can you guess their names?

E A L

E T

A G G

O V A N

Teacher’s 
Note:

Apprise students that humans have the ability to communicate and share information. The 
simplest form of human-to-human interaction is possible only with the help of language 
that people understand. Now, introduce to them that to communicate with a computer, we 
need a language that the computer understands.

1

I reach the inbox as soon as you send me.

You have to post me to correct address. 

The system of communication in speech and writing. 

A talk between two or more people. 
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You are in the kitchen, and your mother instructs you to make Pasta. You can easily 
understand the instructions because your mother is using a language you understand.

Similarly, we need a language that a computer understands to communicate with a computer. 
For every action, a computer has to be given instructions carefully. 

A user inputs instructions into a computer’s memory using a language the computer can 
comprehend. In other words, a program consists of instructions written using a specific 
programming language. 

Hello, Friends! We use language 
to express our views and 
feelings. Now, let us learn the 
language which the computer 
understands. 

Instructions

Program

Software
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Do You Know?
C++ was actually referred to as “The New C.” This is because C++ draws inspiration from C, building 
upon its framework while adding new features and functions to the language.

Similar to how people communicate 
with one another using different 
languages, we may also use 
different programming languages 
to write instructions for a computer 
program. Let us learn about 
Programming.

A Program is a set of instructions that tells the computer what to do. The process of writing 
a set of instructions that tells the computer how to input, process and output data is called 
programming. 

To create a program, we need to learn a programming language. Some popular programming 
languages are listed below.

C C++ Java Python

Ruby Perl Scala Scala

C# Swift R PHP 

HISTORY AND DEVELOPMENT OF PROGRAMMING LANGUAGES

The development of computer languages have been classified into the following categories.
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Let me Answer
What do you mean by 
low-level language?

Programming Languages

Machine 
Language

Assembly 
Language

High-Level   
Language

Fourth-generation 
Language

Fifth-generation 
Language

Machine Language 

(First Generation)- A computer is an electronic device that can only understand electronic 
signals. This language is expressed in binary form, i.e., 0 and 1, where 0 means ‘off ’; this is to 
signify a stage where the current is not flowing in the electronic computer units. The other 
stage is 1, the ‘On’ stage, which signifies the current flowing within the computer circuit.

This language has very high speed and very low memory 
utilisation. But understanding it is difficult and a bit time-
consuming. It is highly dependent on the machine, which is why 
it is also regarded as a Low-Level Language.

Assembly Language

(Second Generation) - Symbols or Mnemonics codes 
are used in this language in place of 0 and 1. For 
example, if you want the computer to add two numbers, 
the mnemonics used for performing this task would 
be ADD. The assembly language programs have to 
be converted into machine language using translator 
programs known as Assemblers since a computer can 
only understand machine language.

High-Level Languages 

(Third Generation) - People created a language due 
to limitations placed on using machine and assembly 
languages with the following features.

ˡˡ User-friendly.
ˡˡ Machine-independent.

Figure 1.1 First Generation Computer

Figure 1.2 Second Generation Computer
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Almost all modern programming languages follow the 
standard of higher-level languages. The syntax of higher-level 
languages is similar to our English Language, which is easier 
and simpler than assembly and machine languages. 
All modern computers need a Translator to convert 
a higher language code to machine language code. 

Translator programs are of two types:

1.	� Interpreter: This translator program converts 
programming code written in a higher-
level language into machine language. An 
interpreter translates line by line, carries out 
the instructions and then repeats the procedure 
for the remaining instructions. 
Interpreter programs are 
preferred for beginners and are 
slow in execution speed.

2.	� Compiler: A compiler is a 
translator program that converts 
programming code written in high-level 
languages into machine language. A compiler 
scans the whole code and converts the code at 
once. 

Fourth-generation language (4GL) - Most fourth-
generation languages are based on Structured 
Query Languages. This language is a combination 
of languages with the following features. 
1.	 High speed of execution.

2.	 Highly user-friendly and designed to reduce the level of programming efforts.

3.	 In this language, the user has to mention only the 
required output, while the computer regulates the 
sequence of instructions that will fulfil those results.

Fifth Generation Languages (5GL) - The fifth-generation 
languages aim to provide an automated solution. It will 
look for an algorithm to solve any given problem and 
then automatically carry out the algorithm to solve that 
problem.

A Specialized Language Called Sql is used to 
update, delete, and Extract Information from 
Databases.

Remember it!

Figure 1.3 Third Generation Computer

Figure 1.4 Fourth-Generation Computer

Figure 1.5 Fifth-Generation Computer
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Generation Popular Programming Languages

First Generation Languages Machine Language

Second Generation Languages FORTRAN, COBOL and ALGOL

Third Generation Languages FORTRAN, Pascal and the C-family C++, 
C#, Objective-C

Fourth Generation Languages Perl, Python, Ruby, SQL, MatLab

Fifth Generation Languages Mercury, Prolog, OP55

Advantages of Learning Programme
1.	� Reasoning Skills: Programming demands solving complex problems. In programming, 

we learn how to break down a large problem into smaller problems and how to solve 
each of these smaller difficulties. This strategy aids in the growth of our reasoning 
skills.

2.	� Enhances Creativity: Making something new from scratch is what programming is all 
about, and this requires creativity.

3.	� Develop Analytical Thinking: Analysis is the initial stage 
in problem-solving. Understanding complicated issues 
and producing simple solutions for them is the core goal of 
programming. This necessitates a thorough examination of the issue at hand.

Let me Answer
What do you mean by 
creativity?

Kids’ IQ
Saurabh’s great grandmother was a programmer in the third generation of computer 
language.  What kind of language did she use at that time?

.............................................................................................................................................
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Let’s Recall
•	 The process of writing a set of instructions that tells the computer how to 

input, process and output data is called programming.

•	 Machine language is highly dependent on the machine.

•	 The syntax of higher-level languages is similar to our English Language.

•	 Fourth-generation languages are based on the Structured Query Language.

•	 The fifth-generation languages aim to provide an automated solution.

Upskill Your Intelligence

A.	 Fill in the blanks
	 1.	� A program consists of instructions written using a specific .................... 

language.

	 2.	 A computer is an electronic device that can only understand ........................ .

	 3.	 Machine language is highly dependent on the ............................

	 4.	 .................... codes are used in the Assembly languages.

	 5.	 In binary language, 0 means ........................ and 1 means ........................... .

B.	 Match the following.

	 1.	 First Generation Languages	 COBOL

	 2.	 Second Generation Languages	 Prolog

	 3.	 Third Generation Languages	 C++

	 4.	 Fourth Generation Languages	 Machine Language

	 5.	 Fifth Generation Languages	 SQL



14Computer -6

C.	 Write T for True statements and F for false statements.
	 1.	 Machine language is expressed in binary form.�

	 2.	 Assembly languages are not converted.�

	 3.	 High-level languages are machine-dependent.�

	 4.	 Interpreter programs are preferred for beginners.�

	 5.	 A compiler converts the code one by one.�

D.	 Answer the following questions.

	 1.	 What do you mean by Machine language?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 2.	 State the difference between compiler and interpreter.

		  ...........................................................................................................................

		  ...........................................................................................................................

	 3.	 How are high-level languages different from Assembly languages?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 4.	 Write the features of the fourth-generation language.

		  ...........................................................................................................................

		  ...........................................................................................................................

	 5.	 What are the advantages of learning a program?

		  ...........................................................................................................................
		  ...........................................................................................................................
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Critical Thinking

	 Rahul has been given a task to complete this task. Help him out to complete 
the table.

Generation Popular Programming Languages

Machine Language

FORTRAN, COBOL 
Third Generation Languages FORTRAN, Pascal and the C- family C++,

Fourth Generation Languages

Mercury

	 A GIRL IS FACING FRONT AND WORKING ON A COMPUTER.
AROUND HER THERE ARE 5 CLOUDS AND INSIDE IT IS WRITTEN: 
C++, Python, HTML, FORTRAN, JS

Team Work

	� Pair up with your friend and collect information about the programming 
languages which you can see in the above picture. Write some lines about 
each of them in the space given below.

	 ....................................................................................................................................
	 ....................................................................................................................................
	 ....................................................................................................................................

	 ....................................................................................................................................
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Advanced Features of 
PowerPoint 2016

At the end of this lesson, the students will be able to:
)) Create Photo Album in a presentation.
)) Understand ink equations to add mathematical equations.
)) Do the screen recording.
)) Add audio and video clips on a slide.

Learning Outcomes

Warm-up

Colour the circle green if the statement is True and colour it red if the 
statement is False. 

Microsoft PowerPoint is a software application that allows you to create 
and show slides to support a presentation.

A slide is a region surrounded by dotted borders on a slide.

WordArt is a feature that creates text effects which are not available 
through font formatting.

In MS PowerPoint, shapes can not be added to the presentation.

Teacher’s 
Note: Assist students in doing the above activity and recall the features of Microsoft PowerPoint 

2016 learnt in Class 5. 

2
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Hello, Friends! Let us learn 
the advanced features of 
PowerPoint..

PowerPoint 2016 provides various tools and features to enhance the appearance of a 
presentation. A presentation is a collection of slides, arranged in a continuous manner. 
Each slide can contain images, videos, tables, shapes and much more that create a greater 
impact on the audience.  

Do You Know?
PowerPoint was first released in 1987 under the name Presenter. Microsoft had to change the name later 
on due to copyright reasons.

Creating Photo Album
The different images used in a presentation make it more engaging. Various photographs 
from the internet and your own personal collection are available for use. You can choose the 
pictures you want from your whole collection with the help of PowerPoint’s Photo Album 
tool. All the photos in the photo album can be collected for quick access while creating a 
presentation.

Follow the given steps to create a photo album for your presentation.

Steps:

1.	 Click on the Insert Tab.

2.	 In the images group, click on the photo 
album drop-down menu.

3.	 Click on the New Photo album option.  
The Photo Album dialogue box appears.

4.	� In the insert picture from a section, choose Figure 2.1 Insert Photo From
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the File/Disk tab to select pictures from your computer. The Insert New pictures 
dialogue box appears.

5.	� Browse and navigate to the desired 
location to select as many as you want, to 
make your photo album.

	� Under the pictures in the album box, the 
pictures that you select will be added.

6.	� Now, go to the Album Layout section and 
select picture layout, frame shape and 
theme accordingly. 

7.	� Click on create button. Your photo album 
presentation is ready.

	 Ink Equations
You can quickly include mathematical 
equations in your presentation by using the ink 
equation tool.

Follow the given steps to add math equations 
to your presentation.

Steps:

1.	 Click on the Insert tab.

2.	� In the Symbols group, click on the 
drop-down arrow of the Equation 
button.

3.	� Click on the Ink Equation option from the list. The Math Input Control dialogue box 
appears.

4.	� Take the cursor to the yellow grid area and click on it. Observe and when a small black 
dot appear, from here you will start writing the equation.

5.	 Now using the mouse, write the equation.

6.	� Once done, click on the Insert button.

After selecting all of the images, you can 
arrange them in the order of your choice by 
using the up and down arrows next to the 
images in the Album box. 

Remember it!

Figure 2.2 Insert New Picture

Figure 2.3 Photo Album
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Let me Answer
How do you feel when you 
see your childhood album? 

Screen Recording

Screen Recording is one of the features of PowerPoint which allows recording computer 
screen with audio. This recording then can be incorporated into your presentation. 

You will require a sound card, microphone, and speakers in 
order to use this feature.

Follow the given steps for adding a screen recording in 
PowerPoint.

Steps:

1.	� Select the slide where you want to record the 
screen recording.

2.	� Click on the Insert tab and in the Media 
group, click the screen recording option.

3.	 Click on the select area button.

4.	� Drag the mouse over the desired region of the screen 
you want to record.

5.	� Click on the record button if you want to add audio 
to the recording.

6.	� To end the Screen recording, place your cursor at the 
top of the computer screen. A pop-up window appears 
and you can click on Stop to save the recording. 

7.	� The currently shown slide will automatically store 
the recorded video.

Figure 2.6 Inserting Screenshot

Figure 2.4 Screen Recording Option 

Figure 2.5 Selecting Area
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 Adding Video Clips in a Slide

Understanding becomes very easy when something is explained using a video. We can 
also insert videos into the presentation. Video clips add liveliness to the presentation. This 
feature enables the audience to engage efficiently. 

Figure 2.7 Inserting video

Follow the given steps to insert a video clip onto a slide.

Steps:

1.	 Click on the Insert tab.

2.	 In the Media group, click on the video drop-down and select This PC option. 

3.	� The insert video dialogue box appears. Navigate to the location and select the desired 
video, then click on insert.

4.	� Once the video is inserted, you can change video shape, border effect, styles and much 
more in the video Format option.

5.	 Click on the Play button below the video clip. 

 Moving Videos On a Slide

Follow the given steps to move videos on a slide.

Steps:

1.	 Select the video.

2.	 Move the video by dragging it to the new location.
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OR

Press the arrow keys to move the video by small amounts. 

 Resizing the video on a slide

Follow the given steps to resize the video on the slide.

Steps:

1.	 Select the video.

2.	 Resizing handles appear around the border of the video.

3.	 Drag any corner in or out as per the requirement.

OR

	� Click on the Format tool tab. In the size group, write the specific video height or video 
width and then press enter.

Kids’ IQ
Farhan wants to add the following Mathematical equation.

Suggest to him the easiest way to perform this task.
.............................................................................................................................................

Let’s Recall
•	 A presentation is a collection of slides, arranged in a continuous manner.

•	 Ink equation tool can quickly include mathematical equations in your 
presentation.

•	 Screen Recording allows recording computer screen with audio. 

•	 We can also insert videos into the presentation.

•	 Video can be moved to the new location.
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Upskill Your Intelligence

A.	 Fill in the blanks
	 1.	 A ............................ is a collection of slides.
	 2.	 Ink Equation tool enables to include ........................... equations.
	 3.	 Using the ........................... tool, you can correct any errors in the part of 

the equation. 
	 4.	 ........................... enables recording computer screen with audio.
	 5.	 Video clips add ........................... to the presentation.
B.	 Write T for True statements and F for false statements.
	 1.	 Videos cannot be resized in a slide.�
	 2.	 Screen recording can be incorporated into your presentation.�
	 3.	� Sound card, microphone and speakers are required for 

screen recording.�
	 4.	 A photo album can be created in the presentation.�
	 5.	 Photo album option is in the ________ group.�
C.	 Answer in one word.
	 1.	 The tab that is used for inserting video files in PowerPoint.
	 2.	 The button used to stop the recording.
	 3.	 The group in which the equation button is present.
	 4.	 The things required for screen recording. 
	 5.	 The tab that is used for resizing the inserted video.
D.	 Answer the following questions.
	 1.	 Write the steps to create a photo album.
		  ...........................................................................................................................
		  ...........................................................................................................................
	 2.	 How can we insert a video clip in the presentation?
		  ...........................................................................................................................
		  ...........................................................................................................................
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	 3.	 Write the steps to move videos on a slide.
		  ...........................................................................................................................
		  ...........................................................................................................................
	 4.	 What is the use of ink equation in PowerPoint 2016?
		  ...........................................................................................................................
		  ...........................................................................................................................
	 5.	 How can we do screen recording?
		  ...........................................................................................................................
		  ..........................................................................................................................

Critical Thinking

Ravneet made a presentation on Water Pollution. She also recorded a 
video of the Yamuna River and added it to the presentation. Now, she has 
realised that the video size is big, so she wants to reduce the size of the 
video but she is not able to do it. Help her to complete this task.

	 ....................................................................................................................................
	 ....................................................................................................................................
	 ....................................................................................................................................
	 ....................................................................................................................................
	 ....................................................................................................................................

Team Work

	 Record a video of the causes of Air pollution which you see in your daily 
life. Create a presentation including those recorded videos and present it 
in the class.

	 ....................................................................................................................................
	 ....................................................................................................................................
	 ....................................................................................................................................
	 ....................................................................................................................................
	 ....................................................................................................................................
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More on MS Excel 2016

At the end of this lesson, the students will be able to:
)) Know about the different keys.
)) Edit a cell in the worksheet.
)) Create a list using an auto-fill feature.
)) Create and copy the formulas.

Learning Outcomes

Warm-up

A balanced diet makes us grow healthier and stronger. Children of your age 
must stick to the right timetable to take proper meals. Complete the diet 
table of the week given below and learn how healthier the food you eat is. 

DAY BREAKFAST SCHOOL 
LUNCH

EVENING 
SNACK DINNER

Monday Whole wheat Bread, 
eggs and milk

Tuesday One Chapati, green 
vegetable and salad.

Wednesday
Thursday Vegetable Salad

Friday
Saturday Boiled vegetable rice
Sunday

Teacher’s 
Note:

From the above activity, introduce to the students that there might be chances when we 
want to replace some meals with others. This needs modification, so it can be done easily 
in Ms Excel worksheet. 

3
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Hello, Friends! In the previous 
class, we learnt the features of 
Ms Excel 2016 and performed 
calculations. In this lesson, we 
will learn about various ways to 
edit the data in the worksheet.

Let us learn the function of a few keys that are used for modifying the data in a worksheet. 

Functions of Keys

Arrow Keys
To move one cell up, down, left, or right, use the arrow keys. The next cell in the worksheet 
can be selected using the Shift + Arrow key combination.

Backspace
You can remove the content of the active cell by pressing the backspace key. We can remove 
one character to the left of the insertion location by turning on the editing mode.

Delete
This key removes the contents of the cell including the formula applied to the selected cells. 
Deleting the content does not affect the cell formats or comments. In cell editing mode, it 
deletes the character to the right of the insertion point.

End
This key can be utilised in different ways.

ˡˡ This key will move the insertion point to the right of the cell content if edit mode is on.
ˡˡ To activate the last used cell in the lower right corner of the active worksheet, press Ctrl 

+ End.

Enter
After entering all of the text into the active cell, we can press the Enter key. As we press enter 
key, the next cell would be activated in the worksheet.
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Home
The first visible row in the worksheet will be activated when we press the Home key.

Page Down
To move one screen down, we can press the Page Down key.

Page Up
To move one screen up, we can press the Page Up key. 

Spacebar
This key can be utilised in different ways.

ˡˡ To select an entire column in a worksheet, press Ctrl + Spacebar.
ˡˡ To select an entire row in a worksheet, press Shift + Spacebar.
ˡˡ To select the entire worksheet, press Ctrl + Shift + Spacebar.

Tab
To move to the right cell of the active cell, we can press the Tab Key. 

Entering Text
Follow the given steps to enter the data in the cell.

Steps:

1.	 Click on the desired cell.

2.	 Type the text in the cell.

3.	 Press the Enter Key.

Editing Cells
We might enter the wrong text or value in the cell. MS Excel allows to quickly and easily 
change the cell value.

Follow the given steps to edit a cell in the worksheet.
Steps:
1.	 Click on the cell you want to edit.
2.	 Double click in the cell or press the F2 Key.
3.	 Erase the cell data.
4.	 Type the new data.
5.	 Press the Enter Key.

Do You Know?
You can edit the cell by clicking the desired 
cell and making changes directly in the 
Formula bar. 
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Using Edit Mode
To update the content of the active cell, we can use The Edit mode.
Follow the given steps to edit the content of a cell.

Steps:

1.	 Double-click on the cell you want to edit.

2.	� Observe the cursor blinking, which 
signifies that the cell is ready for 
editing.

3.	� Change the text and press the Enter 
key.

Press Alt + Enter key combination to enter 
multiple data in the same cell. 

Remember it!

Figure 3.1 Editing Cells

Figure 3.2 Editing Cells with Formula Bar
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Let me Answer
What do you mean by automatic? 
Give an example of a thing which 
works automatically. 

AutoFill

AutoFill feature automatically fills a series of data in your worksheet. For example, we 
may use the list of Months, and days in our worksheet frequently. To make it easy to enter 
repetitive or sequential lists of information, there is a special feature in Excel called AutoFill.

Follow the given steps to create a list using an auto-fill 
feature. 

Steps:

1.	� Enter the first two values you want to start the series 
with.

2.	 Select both the cells in which you have entered the data.

3.	�  Position the mouse pointer over the bottom right corner of the last selected cell. Observe 
the pointer changes to the (+) sign.

Figure 3.3 Ready Mode

Figure 3.4 Edit Mode.
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Figure 3.6 Auto Fill 

Figure 3.5 Enter Desired Values 

Delete Option
Deleting Cells
Follow the given steps to delete the cells.
Steps:
1.	 Select the range of cells to be deleted.
2.	 In the cells group, on the home tab, click on the drop-down arrow of the delete option.
3.	 The delete dialogue box will appear, click on the delete cells.
4.	 Now, choose the desired option.

5.	 The selected cells will be deleted.

Figure 3.7 Delete Cells 

4.	 Drag the mouse to where you want the series.

5.	 Observe the cells filled with the desired values.



30Computer -6

Deleting Rows/columns
Follow the given steps to delete the rows.

Steps:
1.	 Select the row to be deleted.
2.	 In the cells group, on the home tab, click on the drop-down arrow of the delete option.
3.	 Select the Delete sheet rows option.

4.	 The entire row will be deleted.

Creating Formulas
Formulas make the task of performing calculations easy. It lets us perform simple as well as 
complex calculations. In Ms Excel, almost all types of formulas can be applied for performing 
calculations.

Follow the given steps to perform calculations using simple formulas. 

Steps:
1.	 Enter the two numerical values in cells C1 and C2.
2.	 Click in cell C3 where you want to add the formula.
3.	 In cell C3, type =average(C1:C2)
4.	 Press the Enter key.

Observe that the average of the values entered in cells C1 and C2 is displayed in cell C3.

Figure 3.8 Average Formula

Figure 3.9 Formula
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Let me Answer
Is there any difference between 
the formulas you apply in maths 
and on the Excel worksheet? 

Copying a Formula
There are two methods to copy a formula.

Using the Fill Handle
Steps:

1.	 Click in the cell that contains the formula.

2.	 Position the mouse pointer over the lower-right corner of the cell until it turns (+).

3.	� Drag the fill handle over the cells to which you want to copy the formula, then release 
the mouse button. 

Using Copy and Paste
Steps:

1.	 Select the cell that contains the formula, and on the Home tab, click Copy.

2.	 Select the cell or cells where you would like to paste the formula.

3.	 On the Home tab, click Paste.

Kids’ IQ
Have you ever thought about why we use formulas?

.............................................................................................................................................

.............................................................................................................................................

Let’s Recall
1.	 To move one cell up, down, left, or right, use the arrow keys.

2.	 MS Excel allows to quickly and easily change the cell value. 

3.	 AutoFill feature automatically fills a series of data in your worksheet.

4.	 You can remove the content of the active cell by pressing the backspace key.

5.	 There are two alternative methods for copying formulas in Excel.

6.	 In Excel a formula starts with = sign.
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Upskill Your Intelligence

A.	 Fill in the blanks
	 1.	 ........................... key can remove the content of the active cell.
	 2.	 Deleting the content does not affect the cell ....................... or comments.
	 3.	 ..................... feature automatically fills a series of data in your worksheet.
	 4.	 In Excel, a formula starts with the .......................... sign.
	 5.	 To move one cell up, down, left or right, use the .......................... keys.

B.	 Write T for True statements and F for false statements.
	 1.	 In MS Excel, almost all types of formulas can be applied for performing 

calculations. �
	 2.	 Using the fill handle option, we can paste a formula.�
	 3.	 Copy option is available on the File tab.�
	 4.	 Press the F2 key to edit the cell.�
	 5.	 Formulas do not let us do complex calculations.�

C.	 Answer in one word.
	 1.	 By pressing this key, the first visible row in the 
		  worksheet will be activated.	 .....................................

	 2.	 This key is pressed to move one screen down.	 .....................................

	 3.	 Keys combination pressed to select an entire 
		  column in a worksheet.	 .....................................

	 4.	 This key is pressed to move to the right cell 
		  of the active cell.	 .....................................

	 5.	 The mode which is used to update the content 
		  of the active cell.	 .....................................

D.	 Answer the following questions.
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	 1.	 State one difference between Page Up and Page Down key.
		  ...........................................................................................................................

		  ...........................................................................................................................

	 2.	 What do you mean by the Autofill feature?
		  ...........................................................................................................................

		  ...........................................................................................................................

	 3.	 Write the function of the End key.
		  ...........................................................................................................................

		  ...........................................................................................................................

	 4.	 Write the steps to edit the content of a cell.
		  ...........................................................................................................................

		  ...........................................................................................................................

	 5.	 How can we copy a formula?
		  ...........................................................................................................................

		  ...........................................................................................................................

Critical Thinking

Sam wants to create a timetable for self-study. He does not want to type the 
name of all the days on the worksheet. Suggest to him the tool he should use 
to add the days automatically.

..........................................................................................................................................

...........................................................................................................................................

...........................................................................................................................................

...........................................................................................................................................
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Team Work

	� Prepare a mark sheet for 20 students for the subjects- English, Mathematics, 
Science, Hindi and Social Studies.  Follow the given instructions. 

	 •	 Insert a column of Average to the right of the Total column .

	 •	 Insert a row below the fifth row.

	 •	 Using AutoFill feature, fill the roll numbers 1 to 20 for the students. 

	 •	 Find the average using the formula.

 

A boy looking at the timetable for studying.
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Formulas and 
Functions In Excel

At the end of this lesson, students will be able to:
)) Comprehend the significance of formulas and functions.
)) Differentiate between formulas and functions.

Learning Outcomes

Warm-up

Observe the following marks of the students. Fill in the missing numbers.

Roll No. Name English Maths Science Total

1 Anushka 60 52 56

2 Kanchan 65 58 179

3 Surovhi 76 76 241

4 Niharika 68 75 208

5 Shruti 88 89 82

6 Megha 89 68 238

7 Rahul 100 99 72

8 Shubham 87 100 250

9 Utsav 62 53 75

10 Madhvi 62 78 84

4

Teacher’s 
Note: Inform students that the above task can be done quickly and effectively in MS Excel as 

it holds a wide range of formulas and functions that are easy to use. 
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Hello, Friends! As we know, 
Excel is one of the most useful 
programs and can provide us 
with a wide range of tools to 
work. Let us learn how to use 
formulas in Excel. 

Formulas are the user-defined instructions to perform calculations, whereas functions are 	
the pre-defined or in-built formulas that come with excel.

Working With Formulas

A formula establishes a relationship between two or more cells. All Excel formulas have 
the same general structure: an equal sign (=) in the beginning. Using the formulas, you can 
perform simple as well as complex calculations.

The elements included in the Formula are:

•	 References:	 Range of cells included in the calculations.

•	 Operators:	 Symbols that mention the operation to be performed.

•	 Constants:	 �Numbers or text values that do not change.

•	 Functions:	 Pre-configured formulas in Excel. Do You Know?
A range is a rectangular area made up 
of a collection of cells that are close to 
one another.
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ELEMENTS OF FORMULAS IN EXCEL

= C3 + D3 * 4 - Average (E3 : E5)

Constant

Equal to Symbol

Cell Address

Range

Function
Mathematical Operators

Formulas are not case sensitive. E.g. = b5 + 
c5 is similar to =B5 + C5 

Remember it!

Input Modes

Three input modes in Excel control how specific keystrokes and mouse clicks are interpreted. 
These input modes are as follows:

•	 �Enter Mode: This mode appears when you type the equal sign to begin the formula. It 
is the mode you use to enter text.

•	 �Point Mode: Excel enters Point mode when we press any navigation key on the keyboard. 
This is the mode you use to select a cell or range as a formula operand.

•	 �Edit Mode: Excel enters Edit mode when we press the F2 key. 
This is the mode you use to make changes to the formula.

Rules for Entering formulas in cell

1.	 Click the cell in which you want to enter the formula.

2.	 Type = sign to specify that you’re entering a formula.

3.	 Type the Operands and Operators of the Formula.

4.	 Press Enter to get the desired result. 

Let me Answer
What do you mean by Input?
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Formulas in ExceL
Arithmetic formulas
Arithmetic formulas are by far the most common type of formula. They conduct calculations 
by combining numbers, cell addresses, and the result of functions with mathematical 
operators.

Operator Name Example Result

+ Addition =10+5 15

- Subtraction =10-5 5

- Negation =-10 -10

- Multiplication =10*5 50

/ Division =10/5 2

% Percentage =10% 0.1

^ Exponentiation =10^5 100000
Figure 4.1 Arithmetic Operators

Figure 4.2 Comparison Operators

Comparison Formula
An expression that compares two or more numbers, text strings, cell contents, or function 
outputs is known as a comparison formula. The result of the formula gives the logical value 
true if the comparison statement evaluates to be true. If the comparison statement evaluates 
to be false, the formula returns the logical value false.

Operator Name Example Result

= Equal to =10=5 FALSE

> Greater than =10>5 TRUE

< Less than =10<5 FALSE

>= Greater than or 
equal to =”a”>=”b” FALSE

<= Less than or equal to =”a”<=”b” TRUE

<> Not equal to =”a”<>”b” TRUE

^ Exponentiation =10^5 100000
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Reference Formulas
 The following table mentions the operators you can use in reference formulas.

Operator Name Description

: (colon) Range Produces a range from cell reference (for example, 
A1:C5

(space) Intersection Produces a range from cell reference (for example, 
A1:C5)

,(comma) Union Produces a range that is the union of two ranges (for 
example, A1:C5, B2:E8)

Cell Reference
A cell reference is a cell address that can be used in a 
formula to denote a specific cell. We can refer to a cell with 
its address. 

There are three types of cell references:

Relative Reference
When a formula is copied from one cell to another cell, the value in the copied cell 
automatically gets changed. 

Follow the given steps to use the relative cell reference.

Steps:

1.	� Select the cell that contains the 
formula in which the reference of 
other cells is used. In this case, we 
have selected cell C12, in which 
the formula =Sum(C3:C11) is 
written. 

2.	� Click on the copy command 
from the clipboard group under 
the Home tab.

3.	� Select another cell, here we 
have selected cell D12. Click 
on the Paste command from 
the clipboard group under the 
Home tab. 

Figure 4.3 Reference Formulas

Let me Answer
What is the meaning of reference? 
How can you relate it with Reference 
Formulas? 

Figure 4.4 Relative Reference



40Computer -6

4.	� Observe in the Formula bar to check the cell address that you have used in the formula 
gets changed according. Here, D12 has the cell reference from D3 to D11 instead of C3 
to C11. 

Absolute Reference
Use an absolute reference if you want to keep the original references exactly as they were. 
The column reference and the row reference should be preceded by a dollar symbol if you 
want the formula to keep its original reference when it is copied.

Let us see.
Steps:

1.	� Select the cell C12, change the formula 
in the address bar to =SUM($C3: 
$C11).

2.	� Select the cell C12 and click on the 
copy button in the clipboard group.

3.	� Select cell D12 and select the Paste 
button from the clipboard group.

See the values in the address bar, see the 
cell reference is still C3 or C11.

Mixed Reference
A mixed reference is a combination of relative and absolute references. Either a row or 
column has to be locked preceding it with a Dollar symbol.

Steps:

1.	 Add a column In-stock with some values as shown.

2.	� Click on cell C13 and types 
this formula =$C12 - E$12.

3.	� Copy and Paste this formula 
in the cell E13.

See the address bar the formula 
is =$C12-G$12. The reference to 
C12 remains the same but, E12 
has changed.

Figure 4.5 Absolute Reference

Figure 4.6 Mixed Reference



41 Computer -6

References to other worksheets
You can refer to cells in other worksheets within the same workbook. 

Using Copy - Paste Option

Follow the given steps to use Copy-paste option.

Steps:

1.	 Click on the Sheet 1 tab.

2.	 Click on the cell C12 where the SUM function is used.

3.	 Using Ctrl + C, copy the formula.

4.	 Click on the sheet 3 tab and click on the cell C11.

5.	 Press Ctrl + V to paste the formula.

Figure 4.7 Using Copy-Paste Option (1 & 2)

Using Sheet reference

In this, we use sheet number, exclamation mark and cell address to refer to a cell of a particular 
worksheet. For example, Sheet1!D6; means we’re referring to the cell D6 of Sheet1. 

Steps:

1.	 Add Sheet4 to the Workbook and types the values in Sheet4.

2.	 In Sheet4, cell B11 type the formula =1000 +Sheet1!C11.

3.	 Press Enter and observe the changes in the value shown in the cell B11.
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Figure 4.8 Using Sheet Reference

Functions
Functions are predefined formulas in Excel to perform simple and complex calculations. 
Functions eliminate the chance to write incorrect formulas. They accept the arguments and 
return values. Arguments are the information which contains input values to the function. 
The values are given within ( ) parenthesis. Arguments can be numbers or text, etc. Return 
values display Function output. 

Rules to Enter a Function
•	 All Excel functions must begin with = sign.
•	 The function name must be a valid Excel name.
•	 Open and close parenthesis must be placed after the function.
•	 Arguments must be enclosed in Parenthesis. 
Average Function
The Average function returns the average of the range values. The arguments can be a range 
of cells, simply numbers or numbers along with cell reference(s). 

Follow the given steps to calculate the average.

Steps:

1.	 Click on the cell where you want to place the average of values. Let us say C11 sheet 1.

2.	� Select the Insert Function button on the Formulas tab to open the Insert function 
dialogue box.

3.	 Select Average from the list box and click on the Ok button.
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4.	 Drag the mouse pointer to cell D6.

5.	 The cell E6 will display =AVERAGE(C6:06).

6.	 Type the closing parenthesis symbol and press the Enter key.

7.	 The cell E6 will display the calculated result.

Figure 4.9 Insert Function Figure 4.10 Function Arguments

Kids’ IQ
Kanchan has made a spreadsheet for the marks obtained by the students of her class 
in different subjects. Which option should she select to update the spreadsheet if 
she has to change marks in one of the subjects of any student?

.............................................................................................................................................

.............................................................................................................................................

.............................................................................................................................................

Let’s Recall
1.	 An Excel formula starts with an = sign. 

2.	 Formulas are the user-defined instructions to perform calculations.

3.	 Functions are the pre-defined or in-built formulas that come with excel.

4.	 Excel gives you three ways to enter the Edit mode. 

5.	 The Average function returns the average of the range values.

6.	 Mixed reference is a combination of Relative and Absolute reference.

7.	 Absolute reference is used to keep the original references exactly as they were.
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Upskill Your Intelligence

A.	 Fill in the blanks

	 1.	 A formula establishes a .................... between two or more cells.

	 2.	 There are .................... input modes in Excel.

	 3.	 .................... formulas are the most common type of formula.

	 4.	 A cell reference is a cell .................... that can be used in a formula to 
denote a specific cell.

	 5.	 A mixed reference is a combination of .................... and .................... 
references.

B.	 Write T for True statements and F for false statements.

	 1.	 Enter mode begins when we press any navigation key on 
the keyboard.�

	 2.	 Absolute reference is used to keep the original reference exactly 
as they are.�

	 3.	 Functions eliminate the chance to write incorrect formulas.�

	 4.	 We can refer to a cell with its address.�

	 5.	 Arguments must be enclosed in Parenthesis.�

C.	 Define the following.
	 1.	 Functions - 

	 2.	 References - 

	 3.	 Operators - 

	 4.	 Constants -

	 5.	 Comparison Formula
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D.	 Answer the following questions.
	 1.	 Explain the types of input modes.
		  ...........................................................................................................................
		  ...........................................................................................................................
	 2.	 What is the relative reference?
		  ...........................................................................................................................
		  ...........................................................................................................................
	 3.	 What are the rules to enter a function?
		  ...........................................................................................................................
		  ...........................................................................................................................
	 4.	 Write the steps to calculate the average.
		  ...........................................................................................................................
		  ...........................................................................................................................
	 5.	 What do you mean by mixed reference?
		  ...........................................................................................................................
		  ...........................................................................................................................

Critical Thinking

ABC International school organised a cricket match between class VI A and 
VI B. Saumya, one of the students, was asked to prepare a worksheet to store 
the runs scored by each player. Now, she has prepared it and wants to copy the 
data along with the formula and paste it into another worksheet. Suggest to 
her the cell reference she should use to perform the task.
..........................................................................................................................................

...........................................................................................................................................

...........................................................................................................................................

...........................................................................................................................................
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..........................................................................................................................................

...........................................................................................................................................

...........................................................................................................................................

...........................................................................................................................................

..........................................................................................................................................

...........................................................................................................................................

...........................................................................................................................................

...........................................................................................................................................

Team Work

A.	 Create a worksheet in which you would maintain your Monthly Expenses 
on Stationery. The worksheet must have the following headings: S.No., 
Commodity, Price, Quantity. Find the total for each heading by using 
formulas learnt in this chapter. 

B.	 Conduct a group discussion on the topic: Function vs Formula
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Computational 
Thinking

At the end of this lesson, the students will be able to:
)) Comprehend Computational thinking and its importance.
)) Know the components of computational thinking.

Learning Outcomes

Warm-up

You are Mario, tick marks the things you think of while playing this game.

ˡˡ What items do you need to collect?

ˡˡ Determine the exit and the fastest way to reach the finish line.

ˡˡ Different types of enemies and ways to destroy them.

5

Teacher’s 
Note:

Inform students that you always analyse the situation, and think of actions to work out 
a strategy for completing the level in the most efficient way. This is a Problem-solving 
procedure. 
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Hey! Friends. Do you know 
that Computational thinking 
is an interrelated set of skills 
and practices for solving 
complex problems? Let us 
learn about it.

 What is Computational Thinking? 

Computational thinking is the step that comes before programming. It’s the process 
of breaking down a problem into simple enough steps. This can be connected to high-
order thinking skills and is not bound only to computers. It is a 
method of problem-solving that aids the user in comprehending, 
interpreting, and resolving issues.

Computational Thinking Involves:
ˡˡ Logically segmenting a problem into smaller segments.
ˡˡ Application of general concepts to broken problems. 
ˡˡ Searching for recurring patterns in the problem.
ˡˡ Determining relevant details and omitting the unnecessary ones. 
ˡˡ Follow an algorithm to make decisions and produce the right answer.

 Key Skills of Computational Thinking

There are four key skills in computational thinking:
ˡˡ Decomposition
ˡˡ Pattern Recognition
ˡˡ Pattern Abstraction
ˡˡ Algorithm Design

Let me Answer
In what situation do we apply 
high-order thinking skills?
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Decomposition
Decomposition is the method of breaking complicated 
issues into smaller, more manageable pieces. When a 
problem is considered in its whole, many problems appear 
to merge, which causes confusion. But when a problem is 
broken down into parts, it makes getting at the solution 
easier following a step-by-step method. Any work that is 

completed sequentially is easier to complete and 
facilitates understanding of the steps.

Pattern Recognition
A pattern is a repeated design. Our brain 
recognises a variety of patterns in daily life.  
The process of pattern identification is crucial in 
computational thinking since it allows the user to find solutions more quickly. Once a 
problem is broken down, discovering patterns in the broken parts simplifies work.
Pattern Abstraction
A problem can be made easier to think about it by abstraction. 
This entails concealing irrelevant data and displaying just 
relevant information. It is one step that helps us to arrive at a 
logical conclusion.

Algorithm design
Dress yourself up.

Put some money in your wallet.
Go to a shop.

Ask for your favourite chocolate.
If your desired chocolate is available, 

go to step 6 else go to step 9.
Give money to the shopkeeper.
Keep the chocolate with you.

Go back home. 
Ask for any other chocolate.

Go to step 7.

Pattern recognition is the special ability 
of the human brain to not only find the 
patterns but figure out in a logical way

Remember it!

Let me Answer
Have you ever heard the 
world decomportion in some 
other subject?

Figure 5.1 Computational Thinking

Figure 5.2 Decomposition

Algorithm design is setting out the steps 
and rules needed to follow in order to 
achieve the desired outcome.
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 Importance of Computational Thinking
ˡˡ Develops reasoning and logical thinking.

ˡˡ Aids in understanding patterns and sequences.

ˡˡ Once established, an algorithm can also be 
employed in the future, saving time.

ˡˡ By using computational thinking, one not only 
identifies issues but also offers a solution.

 Flowchart in Computational Thinking

The quickest and cleanest way to solve any problem is to define the issue and work your way 
through a flowchart step by step.

Let us work through a flowchart on how to make a cup of coffee.

Start 

Fill Kettle

Heat Water

Pour water in a cup

Put coffee pouch and milk

Stop

Is water boiling?

Yes

No

Do You Know?
Computational thinking is the mental 
skill to apply fundamental concepts 
and reasoning.
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Let’s Recall
1.	 Computational Thinking is a problem-solving process. 

2.	� Computational Thinking is the process of breaking down a problem into simple 
enough steps.

3.	 A problem can be made easier to think about by abstraction.

4.	� Decomposition is the method of breaking complicated issues into smaller, more 
manageable pieces. 

5.	 A pattern is a repeated design.

Upskill Your Intelligence

A.	 Fill in the blanks

	 1.	 Computational thinking is the step that comes before .....................

	 2.	 A .................... is a repeated design.

	 3.	 The process of breaking up a problem into manageable and understandable 
portions is known as .................... .

	 4.	 Computational thinking aids in understanding .................... and 
.................... .

	 5.	 Computational thinking can be connected to .................... skills.

Kids’ IQ
What is one of the key skills of Computational thinking which start with letter D 
and Ends at letter N.

.............................................................................................................................................

.............................................................................................................................................
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B.	 Write T for True statements and F for false statements.

	 1.	 An algorithm once established can be used at later times.�

	 2.	 Pattern Reference is one of the key skills of Computational thinking.�

	 3.	� When a problem is broken down into parts, it makes arriving at 
the solution easily.�

	 4.	 Our brain is not capable of recognising a variety of patterns.�

	 5.	� Computational thinking not only identifies issues but also 
offers a solution.�

C.	 Answer in one word.

	 1.	� The method of breaking complicated issues into smaller, more 
manageable pieces.

	 2.	 The process of identifying a pattern.

	 3.	� This key element of computational thinking hides the irrelevant data 
and display just relevant information.

	 4.	� Setting out the steps and rules needed to follow in order to achieve the 
desired outcome.

	 5.	 The quickest and the cleanest way to solve any problem.

D.	 Answer the following questions.

	 1.	 What is Computational thinking?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 2.	 What is the importance of Computational thinking?

		  ...........................................................................................................................

		  ...........................................................................................................................
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	 3.	 Name the key skills of computational thinking. Explain any two.

		  ...........................................................................................................................

		  ...........................................................................................................................

	 4.	 Define the algorithm with an example.

		  ...........................................................................................................................

		  ...........................................................................................................................

	 5.	 What is pattern recognition?
		  ...........................................................................................................................

		  ...........................................................................................................................

Critical Thinking

Which dice completes the domino pattern? 

?
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Team Work

	 Work with your partner. You and your cousins are planning to meet 
after a long time. You all are looking for probable options, complete the 
flowchart using the instructions given to reach at a result.

Cousins Meetup

Meetup Point

________________________

________________________

The place where you would go.

________________________

________________________

Who wants to do what?

________________________

________________________
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Introducing Python

At the end of this lesson, the students will be able to:
)) Know the python language and its features.
)) Learn the components of Python window.
)) Start python IDLE and interactive mode.

Learning Outcomes

Warm-up

Tara and Mahi are locked inside a room. Their friend has come to unlock 
the door but the lock requires a password. Help her out in decoding the 
password.

6

Teacher’s 
Note:

Inform students that the set of instructions is ‘input’, executing the instructions leads to 
‘processing’ and the answer after decoding the password is ‘output’. Likewise, a computer also 
works in three stages. To get the work done on a computer, you enter the raw data (input), 
a computer operates on this data (processing) and the desired result is obtained (output). 
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Hey! Friends. Computers understand a 
language made up of 0s and 1s, known 
as machine language or low-level 
language. Humans find it challenging 
to write or understand instructions 
using 0s and 1s, so it led to the invention 
of a high-level programming language 
- Python. Let’s learn more about it. 

 What is Python?

A programme is an organised series of instructions that a computer must follow in order 
to do a certain task, and the language used to specify this programme to the computer is 
referred to as a programming language.

Python is one of the most popular programming languages widely used throughout the 
world to create apps for automation, using AI, building applications for websites server-side 
coding, machine learning algorithms and more. 

 Features of Python
ˡˡ Python is an open-source programming language, which 

implies that anyone who is versed with Python is capable of creating new programmes 
and adding them to the available python libraries.

ˡˡ Python is freely available on the internet and can be easily downloaded from www.
python.org.

ˡˡ Python is portable and platform independent means it can run on various operating 
systems and hardware platforms.

ˡˡ Python has a rich library of predefined functions. 
You can use these library modules to add impressive 
functionality to your programs.

ˡˡ Python’s syntax is clear, concise, and simple to 
comprehend.

Let me Answer
What is the full form of AI?

Do You Know?
Python is also a kind of snake which 
is nonvenomous and found in Asia, 
Africa and Australia.



57 Computer -6

Python Interface
Python provides two different modes for writing programs. There are two ways to use the 
Python interpreter:
a.	 Interactive Mode
b.	 Script Mode

Individual statements can be instantly 
carried out in interactive mode. 
Whereas, Script mode allows us to write 
more than one instruction in a file called Python source code file that can be executed.

Installing Python
As we already know that Python can be freely downloaded from the web. It can be installed 
from the Python website, https://www.python.org/.

Follow the given steps to install Python on your computer.

Steps:

1.	 Open www.python.org to download the latest version of Python.

2.	 Click on the Downloads button and click on the button shown in the following picture. 

Python is not named after the snake, but 
after the British TV show Monty Python’s 
Flying circus.

Remember it!

Figure 6.2 Python Download

Figure 6.1 Installing Python
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3.	 Click on Install now in ‘The python Setup’ window to install Python.

4.	 The installation progress will be shown in the progress bar window.

5.	� The installation status will be shown on the last screen. Python will show the following 
screen after the installation process has been successfully completed.

Figure 6.3 Install Python

Figure 6.4 Python Installation Progress Window

Figure 6.5 Completing Python Setup
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 Components of Python Window
Let us learn about the various components of Python Shell.
Title Bar: The name of the application and the document are displayed here.
Command buttons like Minimise, maximise, restore and close are presented here.
Menu Bar: Various tabs such as File, Edit, Shell, Debug, Windows and Help are displayed 
here.
Script Area: The area where you type the code.
Status Bar: Current status of your cursor is displayed here.

 Starting Python IDLE

Follow the given steps to open the Python interface.

Steps:
1.	 Click on the Start button.
2.	 Click on All apps and scroll down to the Python folder and select the IDLE option.
3.	 The Python IDLE screen will open.

Python IDLE and Interactive Mode
Every Windows application has a unique user interface that makes it easier for users to use 
it to its fullest potential. We can perform different tasks like saving, opening, debugging, 
configuring IDLE settings etc. 

Interactive Mode
In Python Interactive mode, the python IDLE screen looks as shown below.

Figure 6.6 Python IDLE
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Python Command in the Interactive Mode

1.	 Open the Python IDLE.

2.	� You can see a welcome message from the Python interpreter with version details and 
‘ >>>’, the python prompt. It is a primary prompt that specifies that the interpreter is 
expecting a command.

3.	 Type the following statement and press the Enter key.

4.	 Observe that ‘Welcome to Python Programming’ and ‘Hello’ is printed on the screen.

 Python IDLE and Script Mode

	 Script Mode
	 Follow the given steps to use the script mode.

Figure 6.7 Interactive Mode

Figure 6.8 Picture
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Steps:

1.	 Start Python IDLE.

2.	 Click New on the File menu.

3.	 Type the commands in the window that opens.

4.	 Click on save on the File menu.

5.	 Name the file with the .py extension. 

Kids’ IQ
To save a python file, which extension do we use?

.............................................................................................................................................

.............................................................................................................................................

.............................................................................................................................................

Figure 6.9 Screenshots 1 & 2

Figure 6.10 Screenshots 3 & 4
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Let’s Recall
1.	 Python is one of the most popular programming languages.

2.	 Python has a rich library of predefined functions.

3.	� Python provides two different modes for writing Python programs: Interactive 
mode and Script mode.

4.	 Individual statements can be instantly carried out in interactive mode.

5.	 Primary prompt specifies that the interpreter is expecting a command.

Upskill Your Intelligence

A.	 Fill in the blanks

	 1.	 Python is an .................... programming language.

	 2.	 Python is freely available on the .................... .

	 3.	 Python provides .................... different modes for writing programs.

	 4.	 .................... statements can be instantly carried out in interactive mode.

	 5.	 The name of the application and the document are displayed on the 
.................... bar.

B.	 Write T for True statements and F for false statements.
	 1.	 Python has a rich library of predefined functions.�

	 2.	 Python is platform-independent.�

	 3.	 The Python prompt specifies that the interpreter is expecting 
a command.�

	 4.	 The area where you type the code is the Status bar.�

	 5.	 You can perform mathematical operations using Python  
Interactive mode.�
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C.	 Arrange the following steps to install Python.

	 1.	 The installation status will be shown on the last screen. Python will show 
the following screen after the installation process has been successfully 
completed.

	 2.	 Click on Install now in ‘The python Setup’ window to install Python.

	 3.	 Open www.python.org to download the latest version of Python.

	 4.	 Click on the Downloads buttons and click on the button shown in the 
following picture.

	 5.	 The installation progress will be shown in the progress bar window.

D.	 Answer the following questions.
	 1.	 What is Python?

		  ...........................................................................................................................
		  ...........................................................................................................................

	 2.	 Discuss the features of Python.

		  ...........................................................................................................................
		  ...........................................................................................................................

	 3.	 Explain the components of the Python window.

		  ...........................................................................................................................
		  ...........................................................................................................................

	 4.	 Write the steps to use the script mode in Python. 

		  ...........................................................................................................................
		  ...........................................................................................................................

	 5.	 Write the difference between an interactive mode and a script mode.

		  ...........................................................................................................................
		  ...........................................................................................................................
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Critical Thinking

Unscramble the words to make the components of the Python window. 

1.	 RTISCP RAAE - ...........................		 2.  LIETT RAB - ...........................

3.	 TTSSUA RAB - ...........................		  4.  UENM RAB - ...........................

Team Work

	 With the help of the Internet, name any four programming languages and 
their developers.

	 Programming Language						      Developer name

	 ______________________					     ________________________

	 ______________________					     ________________________

	 ______________________					     ________________________

	 _____________________					     ________________________
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Introducing HTML

At the end of this lesson, the students will be able to:
)) Know about HTML and its features.
)) Rules for writing HTML codes.
)) Contrast between a container and empty tags. 
)) Design a Web page.

Learning Outcomes

Warm-up

Samaira wants to surf some of the famous websites. Provide her with the 
website links of the following.

7

Teacher’s 
Note: Ask students if they have ever thought about which language is used to build these superb 

websites. Inform them that Markup languages are used to create websites.
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Hello Friends!! We use Markup 
languages to create websites. HTML 
and XML are the most popular 
Markup Languages.
Let’s Learn about one of them, i.e. 
HTML

 Introduction to HTML

HTML stands for Hypertext Markup Language. It is one of the most popular and widely 
used languages for creating web pages. Websites consist of multiple web pages with text, 
pictures, videos, and animation because of HTML. HTML contains a number of tags that 
are easy to learn and work with. 

Tim Berners-Lee developed HTML  in 1991. 

HTML Released Year

HTML 1

1993 1995 1997 1999 2012 2014

HTML 2 HTML 3 HTML 4 HTML 5HTML 
4.01

Key Features of HTML
ˡˡ A platform-independent language.
ˡˡ A very easy and simple language.
ˡˡ It allows us to build tables and add a link to the web page.

Let me Answer
What is the full form of HTML?



67 Computer -6

ˡˡ It offers a flexible way to construct web pages along with the text.

 Terminologies related to HTML

Hypertext
Using tags called Hypertext, a basic text is transformed into a dynamic text. Also, it has the 
unique ability to link to other web pages.

Markup Language
A language which uses special symbols called Tags to format text documents and tells the 
browser how to display the text.

Tags
Tags are the basic building blocks of a web page. Each 
HTML tag carries out a certain task, and some are used for 
formatting text while some are used for adding images and 
videos and some others are used for navigation. 

Webpage
A webpage is a formatted document that is translated and displayed by the web browser of 
your computer system. 

Rules for Writing HTML codes
In order to write HTML codes, we need to abide by some rules. These are:

ˡˡ Tags should always be surrounded by angle brackets. < >

ˡˡ Values given to the attributes should be 
enclosed within the double quotes. 

Tags in HTML

As we know that HTML is a markup language 
which uses tags to markup the content of web pages. Tags are used as keywords in HTML. 
Each tag is used to carry out a certain operation, which browser software can recognise. 
Attributes are characteristics that have been assigned to each tag. Attributes of tags can be 
used to modify their properties.

Let us look into some HTML tags and their attributes.

Let me Answer
Explain Platform independent 
language.

Do You Know?
Html is also called Tag-based 
language.

There should be no spaces between 
< and > in a tag.

Remember it!
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Tag Attributes

<BODY> Background

<Font> Face, size, colour

<IMG> SRC, width, height

The HTML tags can be categorised as
ˡˡ Container Tags: A tag that has both an open and close tag is called a Container tag. For 

Example: <HTML> ........................... </HTML>

		  Opening Tag			   Closing Tag
ˡˡ Empty Tags: A tag that only contains an open tag and no closing tag is called an Empty 

Tag. For Example: <BR>, <HR> and many more.
ˡˡ Block Level Tags: The block level tags start on a new line by default and occupy the 

entire available width. For Example: Paragraph <P>, Horizontal rule <HR>, etc.
ˡˡ Text Level Tags: The text level tags are used to mark up parts of the text. These tags do 

not start with a new line. For Example: Bold <B>, Subscript <sub>, etc. 

Structure of HTML document

The HTML file is a text document that contains markup tags. The markup tags instruct 
the web browser on how to display the webpage. An HTML file is saved with .htm or.html 
extension.

Let us learn the basic structure of the HTML document:

<HTML>

<HEAD>

<TITLE> Title of the web page </TITLE>

</HEAD>

<BODY>

Content of the web page

 </BODY>

</HTML>

Head contains the information 
which is not to be shown on the 
web page whereas Body contains 
the information which is to be 
shown on the web page.

Remember it!
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Designing a Web Page
We already know, how to create a basic HTML document. Now, let us learn to create a web 
page using some different tags.
<html>
<head>
<title> English Essays </title>
</head>
<body bgcolor=”green”>
	 <h1> English Essays </h1>

	 <h2> 1. Importance of trees </h2>
Trees give us life directly and indirectly as they are the source of oxygen production, CO, 
consumption  and source of rain. They are the most precious gift to humanity on the earth 
from nature. We must be grateful, give honour and preserve it for the wellness of humankind. 
We should understand the importance of trees in our lives and do our best to save trees to 
save a life, save the environment on the earth and make the earth a green earth.
</body>
</html>
Type the above in the Notepad window with the desired name.html
This file can be located in Windows Explorer, double-click on the file icon. 

The web page will appear like this:

Figure 7.1 Web page

 Editing An HTML Document

Follow the given steps to edit an existing HTML document.

Steps:

1.	 Navigate to the location where you’ve saved your file.

2.	 Right-click on your file to open the context menu.
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3.	 Move your cursor over the ‘Open with ’ option, and a sub-menu will open.

4.	 Click on the Notepad.

Kids’ IQ
Where do we write the Html document?

.............................................................................................................................................

.............................................................................................................................................

Let’s Recall
•	 HTML stands for Hypertext Markup Language.
•	 Tags are the basic building blocks of a web page.
•	 Attributes are characteristics that have been assigned to each tag.
•	 A tag that has both an open and close tag is called a Container tag.
•	 A tag that only contains an open tag and no closing tag, is called an Empty 

Tag.
•	 The markup tags instruct the web browser on how to display the webpage.
•	 A HTML file is saved with .htm or.html extension.

Figure 7.2 Editing HTML FILE

Once you are done making the changes, you need to save the file by pressing the Ctrl + S 
keys.
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Upskill Your Intelligence

A.	 Fill in the blanks
	 1.	 HTML stands for ........................................ .

	 2.	 ........................................ developed HTML in 1991.

	 3.	 HTML is a platform .................... language.

	 4.	 .................... are the basic building blocks of a web page.

	 5.	 .................... are characteristics that have been assigned to each tag.
B.	 Write T for True statements and F for false statements.
	 1.	 HTML was developed in 1981.�

	 2.	 HTML is a very difficult language.�

	 3.	 Hypertext transforms a basic text into a dynamic text.�

	 4.	 Tags should always be surrounded by curly brackets.�

	 5.	 A tag that only contains an open tag and no close tag 
is called a container tag.�

C.	 Answer in one word.

	 1.	 The basic building blocks of a web page.

	 2.	 A language which uses tags to format text documents and tells the 
browser how to display the text.

	 3.	 A formatted document that is translated and displayed by the web 
browser.

	 4.	 Characteristics of tags that can be used to modify them. 

	 5.	 The tag starts on a new line by default and occupies the entire available 
width.



72Computer -6

D.	 Answer the following questions.
	 1.	 What is the basic structure of the HTML document?
		  ...........................................................................................................................
		  ...........................................................................................................................

	 2.	 Explain different types of HTML tags.
		  ...........................................................................................................................
		  ...........................................................................................................................

	 3.	 Write the rules for writing HTML codes.
		  ...........................................................................................................................
		  ...........................................................................................................................

	 4.	 Explain any three terminologies related to HTML.
		  ...........................................................................................................................
		  ...........................................................................................................................

	 5.	 Write some HTML tags with the ir attributes. 
		  ...........................................................................................................................
		  ...........................................................................................................................

Critical Thinking

Solve the crossword using the 
given clues.

Down:

1.	 The tags which have only an 
opening tag.

2.	 Most commonly used Text 
Editor for web page designing.

3.	 A tag that transforms a basic 
text into a dynamic text.

5.	 An attribute used to change 
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colour of the text in a web page. 

Across:

3.	 Markup language used to create web pages.
4.	 Tag used to define the text to be shown on the web page.
6.	� Tag is used to define what is to be shown on the title bar when the web page 

is opened in the web browser.
7.	 Tag used to define header area of the web page.

Team Work

	 Names of some famous websites are given below. Surf the internet with 
the help of your teacher to find out the programming languages used for 
creating these websites.

	 www.youtube.com - _____________		 www.google.com - _____________

	 www.facebook.com - _____________	 www.twitter.com - _____________
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Introducing Artificial 
Intelligence

At the end of this lesson, the students will be able to:
)) Know about AI and its types.
)) Learn about the history of AI.
)) Understand the components and benefits of AI.
)) Recognise various applications of AI.

Learning Outcomes

Warm-up

Parthik wants to reach the new location. The father has verbally explained 
the way, but he got confused. Which application programme would he use 
to locate the new location? 

A boy and a roadway ahead

8 

Teacher’s 
Note: Guide the students about the application and introduce to them with the word ‘Artificial 

Intelligence.’
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Hello Friends!! As we know, the ability 
to derive information, learn from 
experience, adapt to the environment, 
understand, and correctly utilise 
thought and reason is defined as 
Intelligence. In this Chapter, let us 
learn what Artificial Intelligence is. 

The ability of computers to do a wide range of jobs has exponentially expanded since their 
introduction. Humans are responsible for developing computer systems in terms of speed 
and reduced size. With the progress in technology now, we have self-driving cars, face and 
voice recognition apps, flying drones, voice assistant apps and much more. These applications 
use various technological tools to learn and make decisions independently. This ability of 
applications or machines is known as Artificial Intelligence. 

 Artificial Intelligence

The intelligence demonstrated by a machine is known as AI. This intelligence is almost 
identical to humans. It is a way of making the computer, a computer-controlled robot or 
software which thinks intelligently, as intelligent humans think. 

Artificial intelligence (A.I.) is generally defined as the property of machines that mimic 
human intelligence, characterised by cognitive ability, memory, learning, and decision 
making.

The ideal characteristic of artificial intelligence is its 
ability to rationalise and take actions that have the best 
chance of achieving a specific goal. A subset of artificial 
intelligence is machine learning (ML), which refers to the concept that computer programs 
can automatically learn from and adapt to new data without being assisted by humans. 
Deep learning techniques enable this automatic learning by absorbing huge amounts of 
unstructured data such as text, images, or video.

Let me Answer
Talk about the devices which 
use Artificial Intelligence.
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Artificial 
Intelligence

Machine 
Learing

Deep 
Learning

All is a technique that enables 
computers and machines to mimic 
human intelligence, using logic, 
if-then rules, decision trees, and 
machine learning.

A subset of Al that includes abstruse 
statistical techniques that enable 
machines to improve at tasks with 
experience.

The subset of machine learing 
composed of algorithm that permits 
software to train itself to perform 
tasks, I speech and image recognition, 
by exposing multi-layered neural 
networks to vast amo of data

Types of AI
Artificial Intelligence is of two types- Weak AI and Strong AI. 

Weak AI Strong AI

Weak AI, also known as narrow AI, is artificial 
intelligence with limited functionality.

Strong AI is widely used, and the scope is 
vast.

It is good at specific tasks. It has incredible human-level intelligence.

Weak AI uses advanced algorithms to 
accomplish specific problem-solving or 
reasoning tasks that do not encompass the 
full range of human cognitive abilities.

Strong AI has a complex algorithm that 
helps systems act in different situations, 
and strong AI-powered machines can make 
independent decisions without human 
interaction.

Examples: Alexa, Siri Examples: Automation, Robotics. 
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Perception

Learning Reasoning Problem 
Solving

Language-
understanding

Components of Artificial Intelligence
 Components of AI

a.	 Learning: 
	� The learning stage is the first stage in the growth process of artificial intelligence, just 

like it is for humans. For instance, when training a child to ride a bike for the first time, 
there will be a trial-and-error process during which the child will make mistakes and 
fall off his bike while progressively learning the guidelines and methods required to 
perform the task at hand. Learning is an essential part of AI and happens in several 
different forms. The simplest form of learning is by trial and error. The solution keeps 
on solving problems until it comes across the right results. The programme maintains 
track of all the movements that resulted in success and stores it in its database to use 
the next time the computer is given the same problem.

	� The learning component of AI includes memorising individual items like different 
solutions to problems, vocabulary, foreign languages, etc., also known as rote learning. 
This learning method is later implemented using the generalisation method.

b.	 Reasoning: 
	� Upto around 50 years ago, only humans could practise the art of reasoning. Reasoning 

is one of the fundamental components of artificial intelligence since it can differentiate 
and draw conclusions as well as inferences from the situation. These inferences can 
also be classified as deductive or inductive. Deductive reasoning is where the truth of 
the premise guarantees the truth of the conclusion. In contrast, in the case of inductive 
reasoning, the truth of the premises supports the conclusion, but it cannot be fully 
dependent on the premises. In programming logic, generally, deductive inferences are 
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used. Reasoning involves drawing inferences that are relevant to the given problem or 
situation.

c.	 Problem-solving:
	� Problem-solving is possibly the most important aspect in the development of artificial 

intelligence because the fundamental premise of AI is the development of computer 
programmes and systems that handle issues in a manner comparable to that of humans. 
The problem-solving component in AI allows the programs to include step-by-step 
reduction of the difference, given between any goal state and the current state.

d.	 Perception:
	� In using the ‘perception’ component of Artificial Intelligence, the element scans any 

given environment using different sense-organs, either artificial or real. To provide a 
real-world application of perception in terms of artificial intelligence, many self-driving 
cars function through the perception of different 
physical objects within a given environment, ranging 
from traffic lights, weather conditions, buildings, and 
highways and roads, just to name a few.

e.	 Language Understanding:
	� Natural Language Processing involves machines or robots to understand and process 

the language humans speak and infer knowledge from the speech input. AI is developed 
to easily understand the most commonly used human language, English. This way, 
the platform allows the computers to understand the different computer programs 
executed over them easily.

	 Application of AI
	� AI has been dominant in various fields 

such as –

1.	� Gaming: In strategic games like tic-tac-toe, Minecraft, chess, and others, AI is essential 
because it allows machines to generate many potential outcomes based on their heuristic 
knowledge.

2.	� Health Care: Diagnoses of conditions like cancer, diabetes, and cardiovascular problems 
have been made with success using AI. Also, AI has been playing a very crucial role in 
identifying the right medicine for different disorders. 

3.	� Customer Support: Worldwide, businesses and organisations invest a significant 
amount of money on customer care and put in a lot of effort to give their clients ongoing 
assistance.  Many companies have built chatbots to provide customer support that use 
Natural Language Processing to answer questions about their products and services. 

Do You Know?
SHRDLU was one of the first AI programs to 
understand natural language. 

Let me Answer
What is the literal meaning of 
perception?
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4.	� Banking and Financial Systems: Banks and other financial organisations create 
Smart Apps to assist consumers with check deposits, fraud detection, etc., using AI 
technologies.

5.	� Space Research: Artificial intelligence facilitates satellite communications and extracts 
the maximum value from the images, increasing our understanding of space.  

AI Around Us
AI was developed to improve our daily tasks and make life easier. Let us look at artificial 
intelligence that we see around us. 

Voice Assistant
A voice assistant is a kind of AI software that can comprehend and carry out human spoken 
orders. Examples: Google Assistant, Cortana, Siri and Alexa.

Face Detection

Face detection is an AI technology used for various purposes. We use face detection for 
filters on the face while taking pictures and face ID for unlocking the phone.

Navigation
Navigation apps use AI to update a commuter about traffic congestions in a particular area 
and the estimated time to reach a particular destination. Also, it recommends the best route. 
Example: Google Maps

Face 1  words with mask in 
apple phones.

Remember it!

Figure 8. 1 Siri and Alexa

Figure 8. 2 Face ID
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Robots
Robots are machines that run independently and 
take the place of humans at work. They do not look 
like humans in appearance nor perform exactly like 
humans. They use AI and can do many tasks.
For Example: Vegetable chopper, robot waiter and 
much more. 

Let’s Recall
•	 The intelligence demonstrated by a machine is known as AI.
•	 Artificial Intelligence is of two types- Weak AI and Strong AI. 
•	 AI can understand human language with the help of a concept called Natural 

Language Processing.
•	 Weak AI is also known as narrow AI. 
•	 A voice assistant is a kind of AI software that can comprehend and carry out 

human spoken orders.
•	 AI systems are efficient enough to reduce human efforts in various areas.

Kids’ IQ
Name a few popular apps that make use of AI.

.............................................................................................................................................

Figure 8. 3 Google Maps

Figure 8. 4 Vegetable Chopper
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Upskill Your Intelligence

A.	 Fill in the blanks

	 1.	 The intelligence demonstrated by a machine is known as ....................... .

	 2.	 A subset of artificial intelligence is .............................. .

	 3.	 Artificial Intelligence is of two types ........................ and ......................... .

	 4.	 The learning stage is the ......................... stage in the growth process of 
artificial intelligence.

	 5.	 ......................... are machines that run independently and take the place 
of humans at work. 

B.	 Write T for True statements and F for false statements.

	 1.	 Strong AI is also known as narrow AI.�
	 2.	 Artificial intelligence is almost identical to humans.�
	 3.	 Alexa and Siri are examples of weak AI. �
	 4.	 AI is developed to easily understand the most commonly used  

human language, English.�
	 5.	 AI can identify the right medicines for different disorders.�

C.	 Answer the following in one word.

	 1.	 Component of artificial intelligence which involves
		  machines to process the human language.	 ................................
	 2.	 One of the first AI programs to understand the
		   Natural language.	 ................................
	 3.	 The most important aspect in the development 
		  of artificial intelligence. 	 ................................
	 4.	 An AI software that can comprehend and 
		  carry out human spoken orders.	 ................................
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	 5.	 AI technology which uses face 
		  ID for unlocking the phone.	 ................................

D.	 Answer the following questions.

	 1.	 What do you mean by artificial intelligence?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 2.	 Differentiate between Weak AI and Strong AI.

		  ...........................................................................................................................

		  ...........................................................................................................................

	 3.	 Name the components of Artificial Intelligence. Explain any two.

		  ...........................................................................................................................

		  ...........................................................................................................................

	 4.	 How AI is used in many organisations for customer support?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 5.	 Write any two applications of AI around us. 

		  ...........................................................................................................................

		  ...........................................................................................................................
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Critical Thinking

Read the following conversation carefully and fill the gaps.

Robot and a boy in cloud - Hey guys, what are you talking about?

A boy in cloud: We have reached the location by using ......................... since we 
didn’t know the route.

A girl in cloud : We were able to control the ......................... using ......................... 
and did not have to type down manually. I say that AI is being used here but 
Sandeep disagrees.

Robot in cloud: Ria is correct. AI is being used by the assistant here. 

Team Work

	 AI might become more prevalent in schooling in the near future. How will 
AI aid to enhance the teaching and learning process? Ask your teacher. In 
the space provided here, write down what you know.

	� ____________________________________________________________________

	 ____________________________________________________________________

	 ____________________________________________________________________

	 ____________________________________________________________________
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Internet Services and 
Cyber Security

At the end of this lesson, the students will be able to:
)) Know about Internet services.
)) Learn Netiquettes.
)) Understand the cyber threats.

Learning Outcomes

Warm-up

Look at the pictures given below and identify the icons of the app. Fill in 
appropriate colours in the logos.

9

Teacher’s 
Note: Guide students that life today is highly dependent on computers, but it would have never 

been so popular and widely used if it was not for the Internet.

Figure 9. 1 Firefox black n white logo

Figure 9. 3 Internet Explorer black n white logo Figure 9. 4 Google Chrome Black n white logo

Figure 9. 2 Opera black n white logo
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Hello Friends!! In the previous class, 
we learned how to access the internet. 
In this chapter, we will learn about 
Internet services and cyber threats in 
detail.

Internet is the interconnection of a large number of computer networks all over the world. 
The internet plays an important role to make our life simple. It has revolutionised the world 
and made it into a global village. In a couple of seconds, information can be shared with a 
person anywhere around the globe.

Internet is also used for a variety of services including communication, shopping, banking 
and much more.

Internet Services
We may carry out various operations on the Internet. Further, the Internet allows us to 
access different types of data such as text, images, audio, video and software.

Let us know about some of the Internet Services in detail.

Communication
The internet is currently the most widely used form 
of communication. The rise of the internet has made communicating with others much 
simpler. Apart from sending e-mails, you can talk to others almost face to face over the 
Internet. You only need to click once to share your opinions, thoughts, videos, etc. with 
your friends.

Let us learn           about some of the ways used for communication over the Internet. 

E-mail
E-mail stands for electronic mail. Messages can be sent and received from one computer to 
another through the Internet. E-mail can be sent anytime during the day, anywhere in the world 
and to many people simultaneously. Yahoo Mail and Gmail are some of the popular e-mail 
service providers. If you already have an email account, simply log in to receive and send e-mails.

Let me Answer
For what purpose do you use 
Internet?
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Video Conferencing 
To communicate with your friends and family, you use phones and mobile devices. With the 
development in technology, the person with whom you are talking can be seen as well. This 
online technology which allows users in different locations to hold face-to-face meetings 
without having to move to a single location together is called video conferencing. In video 
conferencing, two or more people can speak to each other simultaneously over audio and 
video from different locations. The basic requirement for video conferencing is a connection 
to the Internet. In addition to this, you need to have a microphone and a webcam connected 
to your computer or laptop.

Video conferencing is a fantastic technology. Companies with multiple offices might 
establish direct video communications between their locations in order to allow their teams 
to work more collaboratively. It has promoted e-learning as knowledge of teachers and 
lecturers living in cities can be brought to remote areas. Surgeons in the medical industry 
can supervise operations taking place in various parts of the world from their own hospitals.

Voice-Over-Internet Protocol (VoIP)

VoIP is the transmission of voice and multimedia content over an internet connection. 
It is basically used for voice communications. It is available on smartphones, personal 
computers, laptops and other hardware devices that can access the Internet. 

Skype and GoogleTalk are the most common and popular VoIP services.

Follow the given steps to use the VoIP service of Skype.

Steps:

1.	 To install Skype on your computer, go to www.skype.com website. 

2.	 Download Skype.

3.	 Double-click on the Skype icon to start Skype.

Figure 9. 5 Inbox of Gmail
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4.	� To create an account on Skype, click on the Sign In or Create button to open the Sign 
In screen.

5.	 Click on Create one! Link. The create account screen appears. 

6.	 Enter your email and click on the Next button.

7.	 Enter a password and click on Next.

8.	 Upload your personal details if you wish to and then click on the Continue button. 

9.	� Further, skype asks you to check the webcam and microphone. Click on continue and 
the Skype Welcome screen appears. 

10.	 Click on the Contacts tab to add your contacts to the Skype account.

11.	 In the Add a new contact dialog box, enter the Skype ID of your friends.

Sky peer-to peer’ is the 
original name of skype.

Remember it!
Figure 9. 6 Creating an Account on Skype

Figure 9. 7 Skype Welcome Screen
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12.	 Select the desired person from the contacts tab to make a call.

13.	 Click on the call button to make a voice call to the person. 

14.	 Click on the video call button to make a video call to the person. 

 Social Networking

A social networking website provides a forum for connecting individuals who share similar 
hobbies or interests. It allows you to share your views, ideas and suggestions. With your 
contacts and friends, you may also share audio, video, and still pictures. Some social 
networking sites let you create groups that share a common interest. 

Facebook, Tumblr, Instagram and Twitter are some of the most common Social Networking 
sites. These are also used as a marketing hub. On these websites, there is large amount of 
knowledge and information is shared from across the world. However, these services are 
typically viewed as a way for students to divert attention away from their studies. So, we 
should use these sites wisely. 

Figure 9. 8 Add a new Contact Dialogue

Figure 9. 9 Facebook site and Instagram site
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E-Greetings
E-greetings are identical to conventional cards in every way. The only distinction is the use 
of digital text and effects to generate it. E-greetings are in soft copy, whereas paper greeting 
cards are in hard copy. This means that you can see an e-greeting on your monitor but you 
cannot touch it. E-greetings can be sent anytime through emails, saving paper and trees in 
the way. An amazing e-greeting is created by the animation effects, music, still images, and 
text. Some of the popular e-greeting websites are www.egreetings.com, www.e-cards.com, 
www.123greetings.com and more.

The recipient of an e-greeting must click on a link sent by the sender of the greeting in order 
to view the e-greeting in his computer browser.

E-Banking
Money can be transferred online from one bank account 
to another. Cheques were used in the past to transfer funds. The clearing of the cheques 
takes two to three days. With e-banking, you can transfer funds easily from one account to 
another through the computer, laptop and even your smartphone. 

Let me Answer
Have you ever sent an e-card 
to anyone?

Do You Know?
The united American Bank is thought to be the 
first bank in the world to offer computerised 
banking at home.

Figure 9. 11 Netbanking pnb

Figure 9. 10 www.123greetings.com



90Computer -6

Advantages of E-banking
ˡˡ Less time-taking.
ˡˡ Minimise paperwork.
ˡˡ Fewer chances of human errors.
ˡˡ financial discipline and promotes transparency.

Disadvantages of E-banking
ˡˡ Lack of direct contact between customer and banking officer.

ˡˡ Security issues,

ˡˡ Internet connectivity is a mandate,

 Netiquettes

The rules and standards that should be adhered to when meeting or conversing with others 
are known as etiquettes. In online communication, there may be a situation when the 
person may misunderstand your remark. A set of guidelines has been created to prevent 
misunderstandings. This set of rules is known as Netiquettes, which stands for Network 
Etiquettes. 

Some common netiquettes are:
ˡˡ Use appropriate language. 

ˡˡ Avoid typing in capital letters as it can be interpreted as if you’re shouting at the person. 

ˡˡ Avoid using the “Reply To All” option when not necessary to answer everyone marked 
in the email.

ˡˡ Try to ignore the sender’s minor typing errors.

ˡˡ The subject of the email must be in relation to the matter of the email.

ˡˡ Avoid sending repeated emails just for the publicity of a product or service.

Cyber Threats
A cyber threat is a malicious act that seeks to damage data, steal data, or disrupt digital life 
in general. Most cyber threats are committed with the intention of making money. 
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Types of Cyber Threats

There are various types of cyber threats. Some of them are as follows:

Data Diddling 
This kind of attack involves altering the raw data just before it is processed by a computer 
and then changing it back after the processing is completed. For example, a student goes 
through the school’s grade recording system and changes the grades of his half yearly exams, 
hence increasing his grade point average.

Phreaking
The crime where hackers attack your voice network like they would (and do) attack your data 
network. Instead of flooding your server with outbound emails, they flood your telephone 
system with outbound calls. Your phone bill will cover the cost of those calls. This is an 
exercise to create revenue for the hackers though, they don’t want you to know you have 
been hacked.

Cloning
This refers to a fraud in which scanners are used to steal the electronic serial numbers 
of cellular phones, which can be utilised for billing purposes and making broadcast calls. 
Clones can be created to make free calls that are charged to the owner of the original cell 
phone using the stolen serial numbers.

Carding
This refers to the process of stealing credit card numbers online, to be resold or used to 
charge merchandise against the account of the victim.

Cracking
The term “cracking” means trying to get into computer systems in order to steal, corrupt, or 
illegitimately view data. The persons who are involved in the process of cracking are called 
crackers. 

Software cracking is considered illegal and cracked software is often called pirated software.

Cyber Security
Cyber security is the practice of defending computers, servers, mobile devices, electronic 
systems, networks, and data from malicious attacks. It’s also known as information 
technology security or electronic information security.
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Privacy and confidential information must be preserved, and the system must be secured 
against malicious theft or disturbance.Unfortunately, cybercrime is becoming more 
prevalent worldwide.

The various reasons for increased cyber crimes are:

ˡˡ Not trained Internet users

ˡˡ Lack of awareness

ˡˡ Increased use of internet

Let’s Recall

•	 Internet is the interconnection of a large number of computer networks all 
over the world.

•	 E-mail stands for electronic mail.

•	 The technology which allows watching the person while talking is called video 
conferencing.

•	 Skype and GoogleTalk are the most common and popular VoIP. 

•	 E-greetings can be sent anytime through emails.

•	 Facebook, Tumblr, Instagram and Twitter are some of the most common 
Social Networking sites.

•	 A cyber threat is a malicious act that seeks to damage or steal data.

•	 Cyber security is the practice of defending computers, servers, mobile devices, 
electronic systems, networks, and data from malicious attacks.

Kids’ IQ
Should we share the one time password (OTP) with everyone?
.............................................................................................................................................
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Upskill Your Intelligence

A.	 Fill in the blanks

	 1.	 ....................... stands for electronic mail.
	 2.	 VoIP stands for .............................................. .
	 3.	 The technology of watching the person while talking to him is called 

....................... .
	 4.	 Netiquettes stands for .................................. .
	 5.	 .................................. were used in the past to transfer funds.
B.	 Write T for True statements and F for false statements.

	 1.	 The Internet is currently the most widely used form of communication.�

	 2.	 E-mail can be sent only during the day.�

	 3.	 Gmail is famous for video conferencing.�

	 4.	 The most common VoIP services are Skype and GoogleTalk.�

	 5.	 We can create groups on social media networking sites.�

C.	 Answer in one word. 
	 1.	 A set of guidelines to be followed in online 
		  communication.	 ...................................
	 2.	 Transmission of voice and multimedia 
		  content over an internet connection.	 ...................................
	 3.	 A forum for connecting individuals who 
		  share similar hobbies or interests.	 ...................................
	 4.	 Cards which use digital text and effects.	 ...................................
	 5.	 The most common social networking site.	 ...................................

D. Answer the following in one word.
	 1.	 What do you mean by cloning?

	 2.	 What is cyber security?
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	 3.	 Discuss different types of communication techniques.

	 4.	 Differentiate between e-greetings and paper greetings.

	 5.	 Explain any three types of cyber threats.

Critical Thinking

Search any five Internet services in the given grid.

A H E B A N K I N G O I P

R B C A S D F G O H J K L

D F D E C V B N M A P V S

C O M M U N I C A T I O N

Q E E A R T Y Y J F V I O

S D F I G O H F G K L P D

Q W E L E G R E E T I N G

Team Work

	 Work in pairs. Sign up yourself with an e-greeting website such as http://
egreetings.gov.in and send an e-greeting to your partner.
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Model Test Paper

A.	 Multiple Choice Questions. (MCQ)
	 Tick (3) the correct option.
	 1.	  HTML was developed in
			  (a)	 1981	 	 (b)	1982	 	 (c)	 1989	 	 (d)	 1987	  
	 2. 	 Hypertext transforms a basic text into 
			  (a)	 a dynamix			   	 (b)	 code text  		
		  (c)	 computer text		  	 (d)	 closing text		
B.	 Fill in the blanks with correct words.
	 1.	 A program consists of instructions written using a specific .....................

language. 
	 2.	 ........................ codes are used in the Assembly languages. 
	 3.	 A ..................... Is a collection of slides. 
	 4.	 Video clips add ..................... To the presentation. 
	 5.	 Using the ....................., you can correct any errors in the part of the 

equation. 
 C.	 Write ‘T’ for True statements and ‘F’ for False statements.
	 1.	 The Button was used to stop the recording. 	
	 2.	 The things required for screen recording. 	
	 3.	 The tab that is used for resizing the inserted video. 	
	 4.	 Functions eliminate the chance to write incorrect formulas. 	
	 5.	 Python has a rich library of predefined functions. 	
D.	 Answer the following in one word.
	 1.	 How are high-level languages different from Assembly languages? 
	 2.	 What are the advantages of learning a program?
	 3.	 How can we insert a video clip into the presentation?
	 4.	 What are the rules to enter a function?
	 5.	 Explain the types of input modes.
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Model Test Paper

A.	 Multiple Choice Questions. (MCQ)
	 Tick (3) the correct option.
	 1.	 The key is pressed to move to the right cell of the active cell 
			  (a)	 Enter				    	 (b)	 Space bar		          
			  (c) 	 Alt+ Enter			   	 (d)	 None of these 	
      2. 	 To Edit cells we have to 
			  (a)	 Double click			  	 (b)	 Right click	   
		  (c) 	 Erase the data		  	 (d)	 Import a new file	  
B.	 Fill in the blanks with correct words.
	 1. 	 A program consists of instructions written using a specific ........................

language. 
	 2.	 HTML stands for .........................
	 3.	 ......................... Are characteristics that have been assigned to each tag. 
	 4.	 Machine language is highly dependent on the .........................
	 5.	 .........................key can remove the content of the active cell.
C.	 Write ‘T’ for True statements and ‘F’ for False statements.
	 1. 	 Functions eliminate the chance to write incorrect formulas. 
	 2.	 We can refer to a cell with its address.	  
	 3.	 Enter mode begins when we press any navigation 
		  key on the keyboard.			 
	 4.	 The copy option is available on the File Tab. 	
	 5.	 Formulas do not let us do complex calculations.	
D.	 Answer the following questions.
	 1. 	 What is the importance of Computational thinking?
	 2.	 Define the algorithm with an example.
	 3.	 Name the key skills of computational thinking. Explain any two.
	 4.	 Discuss the features of Python. 
	 5.	 Write the difference between an interactive mode and a script mode.
.


